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Utilize the Quote Monitor feature to view daily performance data and additional tabs that 

provide quick access to vital asset-specific information such as research, news and events.  

View information about current holdings, indices and economic series

Access the detailed Equity and Fund views by 

entering a known ticker symbol in the Search 

area, or start typing a ticker or name and have 

Intellisense provide a list of matching options.

Search for Equities, Mutual Funds and ETF data

Getting Started

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs

Stock, ETF and Mutual Fund Idea views include:

»» Bull & Bear stocks of the day

»» Market analysis & outlook

»» Stock picking strategies & commentary 

Start idea generation with Zacks Research from the Advisor Tools main menu
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Equity, ETF and Mutual Fund Research

»» Multiple report types are available including Detailed Analysts, Quantitative Snapshot & Digest.

»» Click on the individual icons for Report 

and Snapshot to see reports.

»» Filter views by clicking on any of the 

listed item titles.

»» Want more info about the coverage? Click the get information icon

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs

Not finding a research feature?
Some of the research resources and tools discussed in this 

section are not available in all versions of Advisor Tools. 

»» Enter a ticker in the Ticker(s) input area. Enter 

multiple tickers separated by a comma to 

retrieve research for multiple companies.

»» Quick access to the Analyst, Quantitative 

Snapshot and Digest Reports. Click the report icons to view the individual reports.

»» Refine your search by customizing the Date, Categories, Brokers and/or Industries settings.

»» To get industry-specific reports, leave the ticker area blank, select the desired industry from the 

menu & click Search.

Research History: Detailed Research reports for Equities & Specific Industries

To unlock these features, contact your Zacks 

representative or email  advisortools@zacks.com.
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Zacks Equity Select Lists serve as a starting point 

for long-term investors to build their portfolios.

We offer a number of  ETF Model Portfolios calibrated to meet the range of risk tolerances. 

Note that these options are designed to work as diversified ETF portfolios — not necessarily as a list 

of individual ETF recommendations. The ETFs in each list were selected based on various factors, 

including the ETF’s expense ratios and bid-ask spreads, as well as the Zacks ETF Rank which takes 

into account asset class forecasts.

After clicking on a specific ETF Model Portfolio, you’ll notice two icons next to the portfolio’s name:

After clicking on a Select List, you can 

receive more information about that Select 

List by clicking the get information icon next 

to the name of the list.

Click on the information icon to learn more 

about our ETF Model Portfolios, and how 

they can help with asset allocation.

Click on the performance icon to learn more 

about the performance and risk metrics of 

our ETF Model Portfolios.

Equity Select Lists

ETF Model Portfolios
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Market Strategy Reports

»» Weekly Sector and Market Earning Trends: 

Sheraz Mian, Zacks’ Director of Research, 

offers earnings estimate revisions, expectations 

and analysis of US sectors.

»» Monthly Economic Outlook: The Zacks 

Investment Committee provides detailed 

analysis of metrics affecting the U.S. economy.

»» Monthly Investing Update and Asset 

Allocation: Zacks Chief Equity Strategist, John 

Blank, provides forecasts for all major asset classes and our U.S. and global GDP growth outlook.

»» Quarterly Top-Down Investing Consensus: Summarizes forecasts of many investment 

strategists for major asset classes and discusses reasoning underlying their outlooks.

»» Quarterly Global Macro Investing Consensus: Macro consensus forecasts of global 

commodity prices and foreign exchange rates.

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Click Create Watchlist from File   

»» On the dialog that appears:

›› Download the Import Template in Step 1, complete the 

required fields highlighted in yellow and save the Excel file.

›› Click Choose File and browse to the file 

you just saved.

›› After you have selected the file, click 

Create Watchlist to load the tickers into 

Quote Monitor.

›› A new Watchlist will now appear in Advisor 

Tools with your entered information.

Batch load ticker symbols to a new Watchlist

›› Select the type of watchlist being created (Equities, ETF, MF etc…) 

›› Enter a name for the new watchlist.

›› Enter ticker symbols in the space provided.

»» Click Create a New Watchlist  

»» On the dialog that appears:

Note: You can add/remove 

tickers at a later time as well.

Manually enter ticker symbols to a New Watchlist

The first step to using the Quote Monitor is loading your 

custom tickers for Equities, Funds or Economic data.

Quote Monitor Setup

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Select the symbol(s) to chart using the checkboxes 

next to each symbol.

»» Use the Options menu to change display type to 

Technical, Performance, or 1 Year % Change.

»» Delete will remove the mini chart from current view.

Customize Watchlist Mini Chart

»» Add Ticker: Option to add more tickers to the watchlist.

»» Add Metric to Data View: Allows customization of the items 

selected on the Data tab.

»» Create/Edit Watchlist Alerts: Add alerts for changes in Zacks 

Rank, available reports and financial statements, earnings surprises and more.

»» Create/Edit Model Portfolios Alerts: Add alerts when stock enters or exits  

Zacks Equity Selects Lists.

»» Clear all Alerts: Remove all existing alerts.

»» Add Performance Chart: Creates mini chart with options for performance & percentage change.

»» Collapse/Expand: Minimizes or maximizes the watchlist window. 

»» Hide: Remove the watchlist from view, but not delete the list permanently.

›› Hidden watchlists can be restored by selecting 

Add Watchlist to Dashboard

»» Rename: Change the name of the watchlist.

»» Delete Completely and permanently remove the watchlist. This cannot be undone.

The Options menu provides multiple features that allow 

customization of the existing watchlists.

Make changes to an existing Watchlist

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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Equity, Mutual Fund & ETF Detailed Views

Advisor Tools detailed views are accessed by either clicking on a ticker symbol within the 

system or using the search feature found on the main menu.

»» Key Stats: Many of the most popular metrics for quickly analyzing Zacks model scores, 

company data, financial statements and ratios. Categories include:

›› Valuation Ratios

›› Liquidity and Solvency

›› Management Effectiveness

›› Consensus Price Targets

›› Income Statement

›› Balance Sheet

›› Cash Flow Statement

›› Dividend & Shares

›› Advanced Metrics

›› Price Performance

›› Margins

›› Consensus Estimates

›› Employee Count Metrics

›› Zacks Alpha Scores 

›› Quick Charting ability is available for many of the Key Stat metrics, just click on the 

hyperlinked items or small charts to view chart of selected item.

›› Select Export to Excel from the options 

menu to send all Key Stats to an Excel 

workbook for further analysis.

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Quote: General overview with latest quote, options data and key metrics.

»» Fundamental Chart & Performance Chart: Create, edit and save customized charts.

»» Zacks Research: Access Scorecard and research information with peer comparisons.

»» Estimates: Views include:

›› Detailed Estimates

›› Earnings Estimates

›› Sales Estimates

›› Agreement - Estimate Revisions

›› Magnitude - Consensus Estimate Trend

›› Upside - Most Accurate Estimate Versus Zacks Consensus

›› Surprise - Reported Earnings History

›› Annual and Quarterly Estimates By Analyst

»» Quant Models: Detailed view of Zacks Quant model output.

›› Includes Zacks Rank, Zacks Indicator Score, Style Scores, Earnings Quality, Price 

Response & Insider Rank.	

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Peers: View comparisons for peers, sectors and industries across 

multiple categories and data items.

›› Graphical display shows magnitude of differences:

»» Attributes: Tabular view of data items by categories, with customization 

options to include or exclude sector, industry and peer data. 

»» News: View ticker specific news.

›› Use the list control to isolate 

the provider news displayed: 

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Events: Calendar or list view enables event filtering for 

entire universe of securities or a single stock.

»» Financials: View income, balance sheet, cash flow, segment info & key metrics for 

annual or quarterly periods.  

›› Options allow viewing standard vs company-specific statements & restated vs 

originally reported.

›› Reporting Basis: Select Interim or Annual.

›› Period: Select one of the preset options or Other and enter custom From & To.

›› Form Type: Using the dropdown list select any of the available view types.

›› Report Format: Standard (utilizes a template to combine “like” items) or Company 

Specific (as reported by the company)

›› Update Type: Most Recent (restated data) or Orig. Reported (non-restated data)

›› Update Report Button: Select to refresh view with options selected in prior steps.

›› Click Export to Excel button (     ) to copy data to an Excel worksheet. 

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs

»» Select the date using the 

drop downs.

»» Select the types of events 

you would like displayed.

»» Enter specific ticker symbols to see 

events for only that ticker.
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Charting
The charting features available within Zacks 

Advisor Tools allow for saving chart templates, a 

simple process to add/remove tickers, automated 

loading of Watchlist tickers, plotting multiple 

metrics and many other options.

»» Select a Financial Metric to plot on the chart

›› There are 2 methods to make this selection:

1.	 Type a keyword and let Intellisense feature 

provide a list of options.

2.	 Click Browse and search the categories and 

items to make a selection.

›› If viewing metrics versus a relative ticker is desired, 

check the Relative box and enter the desired ticker.

›› The Zacks Rank is now available as a metric to be 

included on any chart. It can be easily searched for 

or found under Ratings > Company Ratings.

»» Enter an Equity, Economic or Index ticker.

›› The entry areas utilize Intellisense for quickly finding 

results; just start typing a ticker or name until your 

desired item is displayed.  Click the ADD button or 

press ENTER to make selection.

›› Economic & Index areas also have a Browse button 

if a more detailed search is needed.

Fundamental Charts

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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Why can’t I see the Zacks Rank?
The Zacks Rank for stocks, ETFs and mutual funds is not 

available in all versions of  Zacks Advisor Tools. 

To enable access to the Zacks Rank, contact your Zacks 

representative or email advisortools@zacks.com.

»» Customize remaining options to create desired chart layout.

›› Log Scale: Check this box to create logarithmic scaled charts.

›› Recession Shading: Display periods of economic recession 

on the chart.

›› Single Panel: All tickers and metrics are displayed within one 

chart when selected.

›› Panel per Financial Security: A panel is added to the chart 

for each identifier entered.

›› Panel per Financial Metric: Each active metric will be 

displayed in a panel for all identifiers.

›› Raw Value: No transformation of data, values represent the “raw” data stored.

›› Performance: Each series is transformed to a growth series and based to zero.

›› 1 Year % Change: The series are converted to 1yr % change format and ploted on 

each panel.

»» Select a time period using either the preset options or entering custom From & To dates.

»» Export the chart as a PNG image or Print from the menu 

found in the upper right corner of the charting area.

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Open, Open Shared, Save, Save As, Rename, Close, and 

Delete options are available on the main chart menu to assist with 

managing your chart templates and library.

›› After setting all chart options, simply save chart to your library 

for reference later.

›› Retrieve your chart template using Open to load the desired 

chart view.

›› Use Open Shared to open a library of pre-defined charts 

provided by Zacks.

»» Additional option to link the chart to your watchlists.

»» Select either Price Return or Total Return.

»» Format the data as either a Raw Percent change or 

growth of $1,000.

Performance charting options are similar to Fundamental 

charts, but several differences are noted below.

Performance Charts

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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»» Use the Browse feature to select the desired Indicators.

»» Select the desired indicator and then 

click the Select button to proceed.

»» Additional chart options include selecting a style (Line 

vs Candlesticks) and Period (Daily, Weekly or Monthly).

»» After selecting the indicators, set the 

parameters for each indicator.

Technical charting provides multiple options for plotting some of the 

most popular technical metrics on a single chart.

Technical Charts

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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Screening Equities, Mutual Funds and ETFs

»» You can now select from the many predefined screens included with your subscription. To view or 

run the criteria used for each screen, simply click on the Load Screen or Run Screen options.

»» Start by selecting Screening > Stock Screener from the main 

menu and then click the Predefined tab.

›› Load Screen will take you to the Edit Criteria tab 

and display the items and criteria used to determine 

the final output.

›› Run Screen will run the screen criteria on the Zacks 

universe of stocks and display the results.

Zacks’ Predefined Screens will help you find the types of companies 

that meet your criteria. Zacks has included several screens that many 

investors use on a regular basis to find potential winners.

Using Zacks Predefined Screens

Advisor Tools provides easy-to-use screeners for 

Equities, Mutual Funds and ETFs.  To begin the 

screening process, select Screening from the 

main Advisor Tools menu and then the desired 

screener type (Stock, ETF or Mutual Fund).

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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Step 1: 

»» Navigate the item categories to find 

desired data items.

»» Enter parameters for each item and 

Add item to your criteria. 	  

Step 2: 

»» After selecting all data items, run the 

screen and view results by clicking the 

Run Screen button.

Step 3: 
After successfully running the screen criteria there are additional options available to modify, export or 

change the results view.

»» Edit Criteria tab will return you to the data item selection views where you can add and/or remove 

data items from the criteria.

»» Export to Excel button is available when viewing your screen results (bottom right).  

›› When selected, this will export all items and stocks, funds or ETF tickers to an Excel CSV file.

»» Edit View tab allows selection of items to include with the output, but these items do not require 

criteria for screening.  Items are added as display only.

›› Click Edit View and then select the items by clicking the checkbox next to each item.

›› Run the screen again to view new results.

If you’re interested in creating your own stock screens with 

custom parameters, click the New Screen tab and then 

follow the steps noted below. 

Creating a New Screen

Getting Started | Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs
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Stock, ETF and Mutual Fund Table Builders
Our Table Builders allow you to bring in tickers from your watchlists and add up to 

12 metrics to compare your stocks, ETFs or mutual funds. With Table Builder, you 

have spreadsheet functionality within Advisor Tools, so you can easily prepare 

“comp sheets” for various holdings. 

Quote Monitor Setup | Equity, Mutual Fund & ETF Detailed Views | Charting | Screening Equities, Mutual Funds and ETFs | Table Builders

Building a Table

»» Choose a watchlist you wish to use from the 

Display Tickers From pulldown menu.

»» Use the Add Metric option under the 

Options pulldown menu at right to select 

financial metrics to compare. You may 

select up to 12 metrics.

Opening and Saving a Table

»» Use the Select Action pulldown menu at left to open an existing 

table, save a table, or to rename or delete tables. 

Exporting a Table

»» Use the Export to Excel option under the Options pulldown 

menu at right to export your table into an Excel spreadsheet.

NOTE: Data exported to an Excel spreadsheet is no longer dynamic. If you wish to create 
Excel spreadsheets with dynamic data, talk to us about our Zacks Excel Link plug-in.
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(888) 691-0681 advisortools.zacks.com

advisortools@zacks.com

If you ever have questions about Zacks Advisor Tools or 

need assistance, please contact us using the information 

below and we’ll be happy to assist you.

Customer Support
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